What You Make Possible
Troubleshooting Jabber Desktop Clients
BRKUCC-3661
Index

- Jabber Overview
- Jabber Configuration and Deployment
- Troubleshooting
- Common Issues
Jabber Overview
Cisco Desktop Client Evolution

Cisco Unified Personal Communicator (CUPC)

Cisco WebEx Connect

Cisco Jabber for Windows
Jabber Client Architecture

Plugin Runtime  Hub UI Plugin  Contacts Plugin  IM & Presence Plugin  Telephony Plugin  Voicemail Plugin

Jabber Plugins

System Service  Contacts Service  IM & Presence Service  Telephony Service  Voicemail Service

Jabber Services

Common Libs (portability, foundation, logging)  Person Manager  Jabberwerx C++  ECC  CPVE  SIPCC

CSF2G  CSF2G Voicemail

Webex Meeting Plugin
Jabber Client Architecture

- Developed Using C++
  - Reduces Download size
  - Reduces Memory Usage

- Microsoft .NET and Jave Not Needed Any More.
Virtualisation Support

- XenApp 6 for Windows 2008 R2
- XenDesktop 5.0
- XenApp/XenDesktop supported in deskphone mode
- VMware View
- No VXC support
## OS and Office Support

<table>
<thead>
<tr>
<th>OS</th>
<th>32 bit</th>
<th>64 bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP SP3</td>
<td>☑</td>
<td>-</td>
</tr>
<tr>
<td>Windows Vista</td>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>Windows 7</td>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>Windows 8</td>
<td>Roadmap</td>
<td>Roadmap</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Office Suite (optional)</th>
<th>32 bit</th>
<th>64 bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Office 2003</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Microsoft Office 2007</td>
<td>☑</td>
<td>-</td>
</tr>
<tr>
<td>Microsoft Office 2010</td>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>IBM Lotus Notes 8.5.1/8.5.2</td>
<td>☑</td>
<td>-</td>
</tr>
<tr>
<td>Google Calendar</td>
<td>☑</td>
<td>☑</td>
</tr>
</tbody>
</table>
## Localisation

### Language Support

<table>
<thead>
<tr>
<th>Arabic</th>
<th>Italian</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalan (Spain)</td>
<td>Japanese</td>
</tr>
<tr>
<td>Chinese (China)</td>
<td>Korean</td>
</tr>
<tr>
<td>Chinese (Taiwan)</td>
<td>Norwegian</td>
</tr>
<tr>
<td>Czech</td>
<td>Polish</td>
</tr>
<tr>
<td>Danish</td>
<td>Portuguese (Brazilian)</td>
</tr>
<tr>
<td>Dutch</td>
<td>Portuguese (Portugal)</td>
</tr>
<tr>
<td>English</td>
<td>Spanish</td>
</tr>
<tr>
<td>French</td>
<td>Swedish</td>
</tr>
<tr>
<td>Finish</td>
<td>Russian</td>
</tr>
<tr>
<td>German</td>
<td>Thai</td>
</tr>
<tr>
<td>Greek</td>
<td>Turkish</td>
</tr>
<tr>
<td>Hebrew</td>
<td></td>
</tr>
</tbody>
</table>
### User Scaling

#### IM Only vs. Full UC

<table>
<thead>
<tr>
<th></th>
<th>IM Only</th>
<th>Full UC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users per server</td>
<td>25,000 Users</td>
<td>15,000 Users</td>
</tr>
<tr>
<td></td>
<td>per server</td>
<td>per Server</td>
</tr>
<tr>
<td>Users per cluster</td>
<td>75,000 Users</td>
<td>45,000 Users</td>
</tr>
<tr>
<td></td>
<td>per cluster</td>
<td>per cluster</td>
</tr>
</tbody>
</table>

#### IM / Hybrid

- **No Limit**
- **(Largest current 300,000+)**
Contacts

- Add a federated contact
- File → New → Contact
- Enter the JID of the user you wish to add
- Select the ‘Add’ button
Contacts Hub

- Search and dial bar
- Tab Views: Contacts, History, Visual Voicemail, Custom Apps
- Contact: Name, Presence, and photo
- Logged in User
- Manual Presence
- Start voice/video call
- Compact View (Offline contacts hidden)
- Call Forwarding
- Calling Mode (Soft / Desk phone)
Search and Dial Bar

- The search bar is multipurpose:
- Contact names are entered to perform a predictive search
- Numbers can entered to dial
- A classic dial pad is no longer used exposed.

(DTMF tones / dialpad are supported in call)

Search for name or dial number / URI
Searching For Contacts
Look and Feel

- Client provides search across multiple contact record sources.
- Client uses predictive search to refine resolution list as you type.
Searching For Contacts (Cont.)

Behind The Scenes

LDAP based contact Source (On Prem Default)
Active Directory by default but can be customised for other directory environments

HTTP/REST based contact Source (On Prem)
Built into UC Manager 8.6(2)+ and provides and alternative to LDAP integration

WebEx Contact Source (cloud)
Default for cloud based deployments

MS Outlook Contacts
Search local contacts from Jabber (requires 9.1)
NEW in Jabber 9.1
Call Control

Desk Phone Control
- Cisco Jabber for windows controls your desk phone to make and receive call
- Requires Medianet Drivers for Video Calls

Soft phone
- Use a suitable audio device or headset to make calls directly from your computer
Call Control (Cont.)

- Select mode of operation using the system tray icon.
- Drop down list will provide a list of hardware/software associated to user.

- Users can be configured to use just desk phone, just soft phone or both.
Desktop Collaboration

- Video desktop share providing cross device interoperability
- 1-1 Desktop Share (Cloud deployment only)
- BFCP Desktop Share with CUCM 8.6.2+
- Requires COP file
Video Desktop Share

- Simply hitting the “Share” escalation button during a call will add a desktop share to an existing audio / video call.
- The desktop share instantly shares your desktop in real time.

- Based on BFCP standard.
- Share desktop with TelePresence endpoints or other Jabber clients.
Integration with Desktop Applications
Office 2010 – Contact Card Integration

- See who is available directly in Microsoft Office suites
- Easily start
  - Chat
  - Group Chat
- Easily escalate to
  - Voice
  - Video
  - Web Share
Integration with Desktop Applications
Office 2010 – Ribbon Bar Integration

- Escalation to point to point and group chat Function

- Escalation to point to point voice/video calling as well as escalation to multiparty ad-hoc conferencing
Integration with Desktop Applications
Office 2010 – Personal Contacts
Unity Connection Integration

- Visual voicemail provides access to Unity connection directly from voicemail tab.
- Message is played back within the client.
- Cisco Unity is not supported with Cisco Jabber
Calendar Integration

Type 1
Calendar Integration

Type 2
Extensible Tab / HTML Apps

- Can create additional HTML application tabs within the client.
- HTML tabs can exist on web server.
- Examples for tabs:
  - Company Helpdesk/Support info
  - Branch directory
  - Supplier search
  - Social Networking Tab
Jabber Configuration and Deployment
Jabber Installation

- Not Required:
  - Closing other applications
  - Internet access
  - No pre-requisites to be installed.

- Supports single user sign-in per OS profile.
- Administrative rights are required.
- Do not run WebEx Connect client and Jabber client simultaneously.

- There are three methods available to install Jabber:
  - Deploy Jabber using AD/Altiris/SCCM etc. using the MSI and specified command line options
  - Deploy Jabber AD/Altiris/SCCM etc. using a re-packaged MSI (uses a Transform to embed information into the MSI)
  - Run the Jabber MSI
Deployment and Configuration Overview

1. IT Admin provides AD info to UC Admin for sync

3. UC Admin provides IT Admin repacked MSI to deploy

2. UC Admin provisions directory, UC and users on UC servers

Device, Line, User, Jabber, IM and Jabber UC service

IM & P Config. and UDS

CUCM

Sync

UC

Client deployment

4. Client deployment

5. Client starts
   a) Auth. with IM & P
   b) Get config.

CUCM device config.

c) IM & P

d) TFTP jabber config.

e) Unity Connection for VM
Troubleshooting
Server Health

Connection Status

- Softphone
  - Status: Connected
  - Address: 
  - Protocol: CCMCF
  - Device: CEMCEN
  - Line: 1101

- Deskphone
  - Status: Not Connected
  - Address: 
  - Protocol: CTI

- Voicemail
  - Status: Connected
  - Address: 
  - Protocol: IMAP (TCP)

- Presence
  - Status: Connected
  - Address: 
  - Protocol: XMPP

- Directory
  - Status: Last Connect Succeeded
  - Address: 
  - Protocol: LDAP

Cisco Jabber

- Management
  - Account
  - Settings

- Communication
  - Voice Call
  - Video Call

- View
  - Contacts
  - Chats

- Help
  - Report a problem...
  - Check for updates
  - Show connection status
  - Show error notifications
  - About Cisco Jabber
Troubleshooting Checklist

- Detailed Description of Issue
  - Include
    - Username
    - Phone numbers
    - Timestamps
    - Executed Actions
    - Phone Mode
  - Generate a PRT
Problem Report Tool (PRT)

- Creates a Problem Report ZIP File
- PRT is What Usually Cisco TAC Asks For
- Launched in Event of Unrecoverable Errors or a Crash
- Automatically Restarts the Relevant Processes After a Crash
- Or Manually Run PRT
Generating a PRT Manually

OR
Problem Report

- Filename Format
  
  PROBLEM_FEEDBACK_Cisco_Jabber-17-14_29_1-27-2013.zip

- Memory Dump

- Relevant Log Files From
  
  %localappdata%\Cisco\Unified Communications\Jabber

- Configuration Details

- Network Settings

- Miscellaneous System Information

- User’s Comments From Troubleshooting Checklist
Log Levels and Log Files

- Jabber Logs Stored in csf-unified.log
- Location of Log Files:
  \%USERPROFILE\%\AppData\Local\Cisco\Unified\Communications\Jabber\CSF\Logs
- Default Level is Debug
- Logs written in following format:
  Date Time LogLevel [ThreadId] [SourceFile] [component] [function] – message
- Rollover Logs – 10 Logs as well as the current log file
- 10 MB in size each
Tools and Error Codes

- Display each error as a new entry
- Error contains severity, description, code and date/time
Tools and Error Codes (Cont.)

- Error codes are in the format <service-id>:<error-code>
- Service ID’s

<table>
<thead>
<tr>
<th>Service Id</th>
<th>Service Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>System Service</td>
<td>Main jabber service – starts all other services and orchestrates the login process</td>
</tr>
<tr>
<td>1100</td>
<td>Contact Service</td>
<td>Responsible for all contact resolution and searching</td>
</tr>
<tr>
<td>1200</td>
<td>IM &amp; Presence Service</td>
<td>Responsible for all presence and IM as well as presence (primary) authentication</td>
</tr>
</tbody>
</table>

- System Service (Service Id 1000) Error codes

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Unknown</td>
</tr>
<tr>
<td>2</td>
<td>Unable to start feature set (IM, Contacts, Telephony, Voicemail, History)</td>
</tr>
</tbody>
</table>
Tools and Error Codes (Cont.)

- **Contact Service (Service Id 1000) Error codes**

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Unknown</td>
</tr>
<tr>
<td>2</td>
<td>Add contact failed</td>
</tr>
<tr>
<td>3</td>
<td>Set friendly name failed</td>
</tr>
<tr>
<td>4</td>
<td>Remove contact failed</td>
</tr>
<tr>
<td>5</td>
<td>Add group failed</td>
</tr>
<tr>
<td>6</td>
<td>Remove group failed</td>
</tr>
<tr>
<td>7</td>
<td>Add contact group size exceeded</td>
</tr>
<tr>
<td>8</td>
<td>Add contact list size exceeded (total # contacts = 1000, total # contacts per group = 600)</td>
</tr>
<tr>
<td>9</td>
<td>Move contact failed</td>
</tr>
<tr>
<td>10</td>
<td>Add enterprise group failed</td>
</tr>
<tr>
<td>11</td>
<td>Remove enterprise group failed</td>
</tr>
</tbody>
</table>
Tools and Error Codes (Cont.)

- **IM Service (Service Id 1200) Error codes**

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Error Description</th>
<th>Error Code</th>
<th>Error Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Unknown</td>
<td>300</td>
<td>SignOn Timeout</td>
</tr>
<tr>
<td>200</td>
<td>Unknown Login Error</td>
<td>301</td>
<td>Username Not Specified</td>
</tr>
<tr>
<td>201</td>
<td>Authentication Failure</td>
<td>302</td>
<td>Password Not Specified</td>
</tr>
<tr>
<td>202</td>
<td>Internal Server Error</td>
<td>303</td>
<td>Server Not Specified</td>
</tr>
<tr>
<td>203</td>
<td>Account Expired</td>
<td>304</td>
<td>SignOn Process Failed</td>
</tr>
<tr>
<td>204</td>
<td>Upgrade Required</td>
<td>400</td>
<td>SignOff Timeout</td>
</tr>
<tr>
<td>205</td>
<td>SignOn Cancelled</td>
<td>401</td>
<td>SignOff Request Failure</td>
</tr>
<tr>
<td>206</td>
<td>Account Locked</td>
<td>402</td>
<td>ShutDown Failure</td>
</tr>
<tr>
<td>207</td>
<td>Account Inactive</td>
<td>403</td>
<td>Presence Service Startup Failed</td>
</tr>
<tr>
<td>208</td>
<td>Unable To Connect To The Server</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Tools and Error Codes (Cont.)

Sample Log Extract

1200:201

1200  IM & Presence Service  Responsible for all presence and IM as well as presence (primary) authentication

201  Authentication Failure

![Sample Log Extract]

© 2013 Cisco and/or its affiliates. All rights reserved.
Crash & Memory Dump Analysis

Obtain a Memory Dump

Gathering System Information and creating Dump file.
This might take up to 1 minute!
Crash & Memory Dump Analysis (Cont.)

Pre-requisites

– Debugging Tools for Windows 7: 
  - Make sure to select Debugging Tools
Crash & Memory Dump Analysis (Cont.)

Pre-requisites

- Launch WinDbg and Configure Debug Symbols
- Go to File → Symbol Search Path
- Add:
  SRVC:\jabbersymbols*http://gwydlvm376/Jabber%20Symbols;SRVC:\mssymbols*
  http://msdl.microsoft.com/download/symbols
Crash & Memory Dump Analysis (Cont.)

Basic Crash Analysis

- Launch WinDbg
- Select File → Open Crash Dump
- Basic crash analysis
  - in the command window type ‘!analyze -v’
Crash & Memory Dump Analysis (Cont.)

Basic Hang Analysis

- In the Command Window Type `!analyze -hang -v`
Common Issues
Call Forwarding Greyed Out

- Unable to “Call Forward All” calls using Softphone

<table>
<thead>
<tr>
<th>CALL FORWARD SETTINGS</th>
<th>V. MAIL</th>
<th>DESTINATION</th>
<th>CALLING SEARCH SPACE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice Mail</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calling Search Space</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Policy</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forward All</td>
<td></td>
<td></td>
<td>Farbed_ALL_CSS</td>
</tr>
<tr>
<td>Secondary Call</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search Space for</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forward All</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forward Busy Internal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forward Busy External</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forward No Answer</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forward No Answer</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>External</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forward No Coverage</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forward No Coverage</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>External</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forward on CTI</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Failure</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forward Unregistered</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forward Unregistered</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>External</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Call Pickup Group</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Desktop Video Share (BFCP) Greyed Out

**Issue:**
- Unable to Share Desktop
- The icon is greyed out.

**Solution:**
- Desktop Video Share is Currently ONLY Available During an Active Softphone Call.
- This Feature will be available in later releases of the software.
Presence Bobble Not Working in Outlook

Checkpoint 1

- Outlook 2007 and 2010
- Uninstall The following
  - Cisco WebEx Connect
  - Microsoft Office Communicator
  - CUCIMOC/CUCILync
  - CUPC 7.x or 8.x
Presence Bobble Not Working in Outlook

Checkpoint 2

- All Users Must be Global Catalogue Server and have a valid Mailbox
- Active Mailbox on Exchange
- To Check: Press CC or BCC in new message
Presence Bobble Not Working in Outlook

Checkpoint 3

- SIP URI set for proxyAddress attribute in Active Directory
Presence Bobble Not Working in Outlook

Checkpoint 4

- Enable Outlook and Jabber Integration
- HKEY_CURRENT_USER\Software\IM Providers
- Create DWORD: OfficePresenceLogging with Value: 1
- Manually create %userprofile%\Tracing directory, otherwise the logging won’t happen
- Restart Outlook
- Log File Location: %userprofile%\Tracing
- Folder Name: OfficePresence-#.log
Contacts Disappear After Adding

Issue 1

- We get the Following Error Message in PRT:
  Error: [4063] The update failed
- Only Happening for a few Contacts
Contacts
Solution 1

Cisco Unified CM Administration
For Cisco Unified Communications Solutions

Capabilities Assignment Configuration

- Status
  Status: Ready

- User Information
  User ID: 40103

- Capabilities Assignment Information
  - Enable CUP (Cisco Unified Presence)
  - Enable CUPC (Cisco Unified Personal Communicator)

* - indicates required item.
Contact Search is Not Working

Issue 1

- PC Not on the AD Domain
- Works by adding the users manually
Contact Search is Not Working

Solution 1

- Put the Machine on Domain

Solution 2

- Use UDS

```xml
<?xml version="1.0" encoding="utf-8"?>
<config version="1.0">
  <Directory>
    <DirectoryServerType>UDS</DirectoryServerType>
  </Directory>
</config>
```
Phone Control Not Working

- Cannot Control 89XX or 99XX Phones
Account Details Not in Options Menu

- Jabber 9.1 and Later
  
  `<CUCM>`
  `<PhoneService_UseCredentialsFrom>Not_Set</PhoneService_UseCredentialsFrom>`
  `</CUCM>`

- Configuration with Presence no longer working
Pop-up Error Upon Login

Step 1 - Run Following Commands:

- 32 Bit:
  "C:\Program Files\Cisco Systems\Cisco Jabber\wbxcOIEx.exe" /regserver
  "C:\Program Files\Cisco Systems\Cisco Jabber\x64\wbxcOIEx64.exe" /regserver

- 64 Bit:
  "C:\Program Files (x86)\Cisco Systems\Cisco Jabber\wbxcOIEx.exe" /regserver
  "C:\Program Files (x86)\Cisco Systems\Cisco Jabber\x64\wbxcOIEx64.exe" /regserver

Step 2- Uninstall and Reinstall the Jabber Client
Jabber and WebEx Productivity Tools
The Endless Cycle of Conflict

- Requirement: This Software to be Installed on The Same Machine.
- ieatgpc.dll shared by both applications
- Trigger: Upgrade Jabber
- Consequence:
  - WebEx Productivity Tools Reinstalls Upon Launch
  - Different Version of ieatgpc.dll for Jabber now
  - Jabber Installer Launches and Installs ieatgpc.dll Again
  - Different Version of ieatgpc.dll for WebEx Productivity Tools
  - …
- Bug: CSCtz84051 (Fixed in Version 10)
- Workaround:
  - Uninstall WebEx Productivity tool.
  - Uninstall and re-install Jabber Windows
  - Re-install WebEx Productivity tool
Phone Control is Not Working

Symptoms and Cause

- **Symptoms**
  - User Authenticates
  - IM/Presence Functions Correctly
  - Phone Control Does Not Work
  - Option > Phone Accounts Shows a Spinning Wheel

- **Cause**
  - Jabber Authenticates with Server
  - Attempt to Locate CCMCIP Profile (Cisco Unified Communications Manager IP Phone)
  - CCMCIP: List of Associated Devices for User
Phone Control is Not Working

Resolution

- **CUCM Config**
  - Verify CCMCIP (Cisco CallManager Cisco IP Phone Service) is Running.
  - Device is Associated to User

- **CUPS Configuration:**
  - CCMCIP Profile is Configured
  - CCMCIP Profile Associated With Correct User
  - Correct CCMCIP Host
  - Audio Profile is Configured
  - Audio Profile associated with the correct User
Display Photo is Not Updated

- Photos Downloaded to
  C:\Users\<userid>\AppData\Local\Cisco\Unified Communications\Jabber\CSF\Photos

- The issue seen in
  - Default thumbnailPhoto from AD
  - Jabber-Config.xml Photo Substitution
    <PhotoSource>sAMAccountName</PhotoSource>
    <PhotoURISubstitutionEnabled>True</PhotoURISubstitutionEnabled>
    <PhotoUriSubstitutionToken>sAMAccountName</PhotoUriSubstitutionToken>
    <PhotoUriWithToken>http://URL/sAMAccountName.JPG</PhotoUriWithToken>

- Bug: CSCtz78946

- Workaround: Delete the old file from location above.
Video Tab is Missing in Options Menu

- User in Desktop Mode
- Softphone CSF disabled for Video
- Admin Disabled Video
- User is an IM-Only User
  - Check here:
    - CUP -> Application -> Cisco Jabber -> User settings -> Application profile
    - If No CTI Gateway and no CCMCIP Profile Then no Video Option.
Error code CJ:1000:1 on the Jabber client

Symptoms:
– Unknown Error Message CJ:1000:1 in The Notification Area After Login

Cause:
– Log into Jabber While Still Logged into Another Jabber Client. E.g. Jabber for Mac
– Bug: CSCtz42069 (Fixed in 9.0.4 Already)

Fix:
– Upgrade to Latest Version.
Complete Your Online Session Evaluation

Give us your feedback and receive a Cisco Live 2013 Polo Shirt!

Complete your Overall Event Survey and 5 Session Evaluations.

- Directly from your mobile device on the Cisco Live Mobile App
- By visiting the Cisco Live Mobile Site [www.ciscoliveaustralia.com/mobile](http://www.ciscoliveaustralia.com/mobile)
- Visit any Cisco Live Internet Station located throughout the venue

Polo Shirts can be collected in the World of Solutions on Friday 8 March 12:00pm-2:00pm

Don’t forget to activate your Cisco Live 365 account for access to all session material, communities, and on-demand and live activities throughout the year. Log into your Cisco Live portal and click the "Enter Cisco Live 365" button.